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Introduction to TriPlot ver. 2.1
TriPlot is an interactive plotting program for trilinear data.    The program was constructed for scientific use
where accuracy and publication quality output is essential.

This Help file is the only manual available with TriPlot.    TriPlot uses standard Windows conventions for 
menu headings and keystrokes.    Context sensitive help, using the F1 key, is available throughout the 
program.    Please browse through this help file to learn more about TriPlot!

See Also:
Contents
How Do I...?
The TriPlot Screen
Copyright Information
Warranty/Disclaimer
Licensing/Registering TriPlot
Index



File Menu

The file menu contains options to input, save, and print data.    The file menu is also used to exit the 
program.

See Also...
New
Open
Close
Save
Save As
Print
Printer Settings
Page Setup
Export Image
Exit



New

Creates a new form containing a TriPlot diagram.    Data can be entered into this diagram (see "Entering 
Data From the Screen" and "Manipulating Data in the Spreadsheet") as long as    the diagram is active.



Open...

Displays the Windows file-open common dialog box, permitting the user to select a TriPlot compatible 
data file (.TRI).    See the Windows 3.1 manual for information on using the file-open common dialog form.



Close

Prompts the user to Save the current file if data has been entered since the last Save, and then erases all
data and closes the active TriPlot diagram.



Keyboard Input

Permits the user to enter raw three-component data, and a sample name, and to select a symbol type for 
the sample.    The data are entered in a pop-up form for the A, B, and C axes (A is the top peak, B and C 
are counter-clockwise from A, respectively).    The data are retained/stored as raw values, however, the 
data are normalized for display.

This menu item can be accessed numerous times to continually add data.

See Also:
Using the Spreadsheet to Enter Data



Save...

Saves TriPlot data into a TriPlot compatible data file, using the currently active file-name.    If the data in 
the diagram was not been previously saved or entered from a data file, a Windows file save common 
dialog box is displayed to enter a file name.

Note:    If you are saving from the Keyboard Input routine (spreadsheet), be careful not to have any blank 
rows.    All data entered below the blank row will be lost.

See Also:
Saving Only Part of the Data Entered



Save As...

Permits the user save TriPlot data into a file.    The name of the file is entered into a Windows file-save 
common dialog box.    The default file extension is .TRI, however, you may name the file with any 3 digit 
extension.    See the Windows manual for information on using the file-save common dialog form.

Note:    If you are saving from the Keyboard Input routine (spreadsheet), be careful not to have any blank 
rows.    All data entered below the blank row will be lost.

See Also:
Saving Only Part of the Data Entered



Print

This command prints the TriPlot figure to the current active printer according to the page dimensions 
given in the Page Setup option.

See Also:
Printer Setup



Printer Setup

This optoins displays the Windows common dialog box used to select a printer and a printer connection.



Page Setup

This option displays a dialog box that allows you to set the dimensions of the page to be printed.

Note:
All dimensions refer to the printable portion of the printer page.    The printable portion may not be 
identical to the page size for many laser printers.



Export Image

This option allows the TriPlot image to be saved to a " .BMP" file.    

In later versions of the program, this option will allow the TriPlot image to be converted to a Windows 
metafile, BMP, GIF, etc...



Exit

Closes all TriPlot forms and exits TriPlot.    If data was entered and not saved, a prompt is given to inquire 
if the data should be saved.



Edit Menu

The edit menu is used to manipulate data that was entered and to access the Windows Clipboard.

See Also...
Erase Last Point
Erase All Points
Cut
Copy



Erase Last Point

Erases the last point entered from a file, the keyboard, and the screen input.    Continually selecting this 
menu item will back-erase all of the data from memory.

See Also:
Erase All Points

Note:
Hitting the "Del" key acts the same as selecting this menu item.



Erase All Points

Erases all points shown on the active TriPlot diagram.    This options differs from the New option under the
file menu in that the a new diagram does not appear.

See Also:
Erase Last Point



Cut

Copies a bitmap of the trilinear diagram to the Windows Clipboard and then clears the diagram and the 
data.    This command is the same as selecting Edit-Copy followed by File-New.    Use this function to 
paste a copy of the trilinear diagram into a word processor document, graphics image, or spreadsheet.

See Also:
Cutting From the Data Entry Spreadsheet



Copy

Copies a bitmap of the trilinear diagram to the Windows Clipboard.    The diagram is not cleared and the 
data remains stored in memory.    Use this function to paste a copy of the trilinear diagram into a word 
processor document, graphics image, or spreadsheet.

See Also:
Copying From the Data Entry Spreadsheet



Window Menu

The Window Menu option allows you to manipulate the positioning of open TriPlot diagrams.    Additionally
you can change the appearance of one or all of the open TriPlot diagrams by adding overlays, turning on 
and off grids or tick marks, or changing the color of the points.

See also..
Cascade
Horizontal Tile
Vertical Tile
Arrange Icons
Triangle Settings
Axes Settings
Overlay File
Point Styles
Point Color
Redraw



Cascade

Arranges open TriPlot windows in an overlapping pattern so that the title bar of each window is visible. 

See Also:
Horizontal Tile
Vertical Tile
Arrange Icons



Horizontal Tile

Arranges open TriPlot windows on top of each other so that all windows are visible. 

See Also:
Vertical Tile
Arrange Icons
Cascade



Vertical Tile

Arranges open TriPlot windows side by side so that all windows are visible. 

See Also:
Horizontal Tile
Arrange Icons
Cascade



Arrange Icons

Arranges into rows all TriPlot icons. 

See Also:
Horizontal Tile
Vertical Tile
Cascade



Triangle Settings

Allows the appearance of the TriPlot triangle to be changed.    Possible changes include: turning on/off the
interior grid, turning on/off exterior ticks, applying an overlay of fields, size of the symbols, and axes 
labels.

See Also:
Axes Settings



Axes Settings

Allows the axes labels or axes font to be changed.    This option is available through the Window menu, or
by clicking the right mouse button while the mouse cursor is over an axis label.

See Also:
Triangle Settings



Overlay File

An overlay file contains the coordinates used to draw lines which classify regions of the triangular plot.    
To choose an overlay file click on the Window menu and then the Overlay File choice, or click the right 
mouse button while the mouse cursor is inside the triangle and choose Overlay File from the menu.

See Also:
Creating a TriPlot Overlay File



Point Style

Displays a floating form of point styles.      Select the open / closed buttons at the bottom of the form to 
change the fill style.    The selected symbol will be the default symbol.

This option is available through the Window pull down menu, or by clicking the right mouse button while 
the mouse cursor is over the triangle.



Point Color

Allows the color of the points being plotted to be changed.      This choice calls the Windows color dialog 
box.    All points on the TriPlot diagram will be changed to color selected.    The color selected will be the 
default color.

This option is availble through the Window pull down menu, or by clicking the right mouse button while the
mouse cursor is over the triangle.



Redraw

Redraws the active TriPlot image.      

Occassionally, an unexpected error may occur which will display your TriPlot image incorrectly.    This 
option will redraw the image and correct the problem.

This option is availble through the Window pull down menu.



Menu Commands

TriPlot contains 4 pull-down menus.    The menus contain commands to input, erase, and print data, set
how the data is displayed, and to obtain help.    The menus are accessed by holding down the Alt. key

and typing the first letter of the menu.    Alternatively, the menu can be opened by clicking the menu title
with the mouse pointer.    Items on each menu are selected by typing the first character of the menu item,

highlighting the menu item with the arrow keys and hitting Enter, or clicking the menu item with the
mouse.

File Menu

Edit Menu

Window Menu

Help Menu



Help Menu

The help menu displays this help system and contains information about the program.    The menu items 
are:

See Also:
Contents
Index
Search For Help On...
Using Help
About...



Contents

Starts Help and displays the topics in TriPlot Help. 

Go To TriPlot Contents



Index

Displays the Help Index for TriPlot.



Search For Help On...

Opens the Search dialog box for Help. You can look up Help information by using keywords in the dialog 
box. 



Using Help

Calls the Windows help file which describes how to use Help. 



About...

Displays a box with information about the authors, the TriPlot version number, and limited system 
resources.



Warranty/Disclaimer

All disks are warranted to be readable.    The authors of this code hereby disclaim all other expressed and
implied warranties for the software, including the warranties of merchantability and fitness for a particular 
purpose.

The user of the software agrees to accept and use the program material as it is, at their own risk, relying 
solely upon their own inspection of the program material and without reliance upon any representation or 
description concerning the program material.    In no event will the authors of the code, nor any 
organizations they represent, be liable for any damages, including any lost profits, lost savings or other 
incidental or consequential damages arising out of furnishing, use of or inability to use, or performance of 
such software.

Should any of your disks be unreadable, please return the suspect disk(s) to us and we will send a new 
copy of the disk.



Copyright Information

This program and its code are Copyrighted by the authors.    This program and its code are therefore 
proprietary and the terms of copying the software is as follows.

1) Copying of this software for backup purposes by the purchaser is allowed without permission of the 
authors.

2) The authors do not allow users to copy this software for commercial resale distribution to outside 
individuals or organizations.

3) The authors may provide the user with, in some cases, written permission to copy this software 
package for other purposes (e.g. educational).

Through the use of this program, the purchaser, its employees, successors, and assigns, agree to the 
terms of the code and program Copyright and Warranty.



Creating a TriPlot Data File

The TriPlot data file is a comma- and quote-delimited ASCII file.    The file is created by TriPlot when Save
or Save As... is selected.    If you always enter data from the keyboard or from the screen input option,

you will never need to manually create a TriPlot data file.    If you must make your own data file, this help
text describes the file format.

The following lines are a file distributed with TriPlot called TRI1.TRI.

"The A Axis"
"The B Axis"
"The C Axis"
"Sample 1",10,20,30,1,1
"Sample 2",20,30,10,1,1
"Sample 3",30,10,20,1,1
"Sample 4",100,100,100,1,1

The first three lines contain the axes labels.    Because these data are text, they must be surrounded by 
double quotes. The next four lines contain the sample data.

The first item is the quote-delimited sample name which can not be greater than 20 characters.    It is 
followed by a comma and 5 numbers also separated by commas. The first 3 numbers are the raw data.    
These data do not need to be normalized to 100 - TriPlot will handle the normalization.    The last two 
numbers are the symbol type (1-8) and the fill status (0-1). The symbols are cross (1), X (2), triangle (3), 
down triangle (4), box (5), diamond (6), circle (7), star (8).    Do not use other values - TriPlot will bomb.    
The fill status is open (0), and filled (1).    Only these values will be honored.



Creating a TriPlot Overlay File 

The TriPlot overlay file is a comma- and quote-delimited ASCII file.    TriPlot does not create this file, and
you must make your own to use with TriPlot.    Windows Notepad is more than adequate.    Future

versions of TriPlot will permit you to draw the separator lines on the screen and will save the overlay    file
for you.

This text will describe the file format. As an example, the file GSFOLK-G.OVL will be used to illustrate the 
file format. This file is reproduced below. 

"Gravel (> 2mm)","Mud (< 0.0625 mm)","Sand (0.0625 - 2 mm)"
80,20,0,80,0,20
30,70,0,30,0,70
5,95,0,5,0,95 
1,99,0,1,0,99
80,10,10,0,50,50
80,5,15,0,10,90
5,85,10,0,90,10

The first line contains the overlay's A, B, and C axes.    The labels are surrounded by quotes and 
separated by commas.    The remaining data lines are used to draw the field separator lines.    Each line 
contains 6 values separated by commas.    The first 3 values are the starting point of the separator line 
and the last 3 values define the end point.    You do not need to use normalized data, but it is easier to 
create the separator lines if you use logical beginning and ending points.

The data file must be saved with the extension .OVL. Only .OVL files are shown in the Overlay Setup 
common file-open dialog box.

Please contact the authors for other overlay files.    We may have the overlay already created for you or 
could create it for you in minute.



 Authors

We would like to thank you for using TriPlot for Windows.    We value your input and will actively keep 
upgrading TriPlot based upon your responses.    We anticipate that future versions will have many more 
functions.

The authors are working on several other Windows compatible programs that will be available in the next 
several months.    The following is a list of expected products:

DigiLog- a screen digitizer for well logs and other scanned images.
Rose - a rose diagram plotting program with vector statistics.
Sieve - a grain-size analysis plotting program for sieved data.
TriLin - a Piper(1944) diagram plotting program.

We can also develop pre-processors and post-processors for Windows- and DOS-based programs.    
These interfaces and plotting programs are a must for working with USGS and EPA programs that work in
batch modes.

Thanks,
Steve and Todd. (10-8-93)



Position

This part of the screen indicates the position of the mouse pointer relative to the A, B, and C axes when it 
is over the diagrams plotting region.



Number of Points On the Diagram

This part of the screen indicates the total number of points currently plotted on the diagram.



Sample Name

This is the name of the sample which is closest to the mouse pointer.



File Name

This is the name of the file which contains the data being displayed on the TriPlot diagram.



How Do I...?

Enter Data From the Screen
Change Point Properties
Change Triangle Properties
Copy Data From One Triangle to Another
Create a TriPlot Data File
Create a TriPlot Overlay File
Create a Windows Metafile
Find Points on the Triangle
Saving Only Part of the Data Entered
Use the Spreadsheet to Enter Data



Entering Data from the Screen

Triplot permits data to be entered directly on the computer screen.    This function is useful for rapid 
plotting of points, although entering data into the keyboard form is more accurate.    Two methods are 
available:

Setting Points with the Mouse

When the mouse cursor is over the triangle, the cursor changes to crosshair and the cursor coordinates 
are displayed along the top bar of the window.    Click the left mouse button on the triangle, and a point is 
set at the A, B, and C coordinate of the cursor.

Setting Points with the Arrow Keys

The arrow keys and number keypad can be used like the mouse to set points.    This method is slightly 
more accurate.    Use the arrow keys to move the mouse cursor over the triangle.    The cursor will change
to a crosshair and the cursor coordinates are displayed on the top bar of the window.    Press the Insert 
key, and a point will be set at the A, B, and C coordinates.



Change Point Properties

All points can be easily edited by selecting Keyboard Input... from the File menu.    However, you may only
want to change a single point.    In this case, move the cursor over the point, hold down the Ctrl key, right 
click the point.    A form will be displayed that contains the properties for the point.    The form permits you 
to edit the sample name, point coordinates, and symbol type.    Tab between the input boxes to change 
the sample name and coordinates, and double click on the point symbol to cycle through all of the 
possible point types.

See Also:
Entering Data From the Screen



Change the Triangle Properties

The characteristics of the triangle can be changed by right clicking on the triangle.    A context sensitive 
menu will be displayed.    Select from the menu the settings that you wish to change.

See Also:
Triangle Settings...
Axes Settings...
Overlay File...
Point Style...
Point Color...



Copying Data From One Triangle to Another

To copy data from one triangle to another, simply click on the triangle containing the data to be copied.    
Then, while holding down the left mouse button, press the Ctrl (control) button of the keyboard and drag 
the mouse pointer to the triangle which will recieve the data and let the mouse button up.    You will see all
of the points have been copied to the appropriate triangle.



Manipulating Data in the Keyboard Input Spreadsheet

The keyboard input form uses a spreadsheet to hold the data.    The spreadsheet implements many of the
standard keystrokes used by major spreadsheet vendors.    They are:

F1 - Provides help for the object of focus.
F2 - Edits a cell.
End - Move to the end of a row.
Home - Move to the beginning of a row.
Ctrl-End - Move to the lower right corner of the spreadsheet.
Ctrl-Home - Move to the upper left corner of the spreadsheet.
PgDn/PgUp - Moves one screen full of data up or down.
Shift-arrows - Highlights cells.
and movement
keys
Del - Deletes the contents of a cell or highlighted range of cells.
Shift-Del - Deletes the contents of a cell or highlighted range of cells and saves the deletion to the 

Windows Clipboard.
Ctrl-Ins - Copies the contents of a cell or highlighted range of cells to the Windows Clipboard.
Shift-Ins - Pastes compatible data from the Windows Clipboard to a highlighted range of cells.    It 

is important that you highlight the cells you wish to paste into.

The spreadsheet has built-in standard equation capabilities.    For instance 2*6 will be shown as 12; 2^6 
will be shown as 72; (2*12+3)/3 will be shown 9; etc.

You may also move through and highlight the spreadsheet using the mouse.    A right click on the 
spreadsheet imitates the F2 key being pressed.



Finding Points on the Triangle

To find out what the ID, coordinates, etc.. of a point on the TriPlot triangle, move the cursor over the point,
hold down the Ctrl key and press the right mouse button.    A form will be displayed that contains the 
properties for the point.    The form permits you to edit the sample name, point coordinates, and symbol 
type.    Tab between the input boxes to change the sample name and coordinates, and double click on the
point symbol to cycle through all of the possible point types.

See Also:
Entering Data From the Screen



Saving Only Part of the Data Entered

To save only part of the data contained in a file enter the Keyboard Input portion of TriPlot (through the 
"File, Keyboard Input" menu option).    Highlight the portion of spreadsheet containing the data you wish to
save and choose the Save As... option (through the "File, Save As..." menu).

Note:    Be careful not to leave any blank rows after your edit.    All data entered below the blank row will 
be lost when the file is saved.



TRIPLOT Help Index

The Help Index contains an alphabetical list of TriPlot topics.    Select the highlighted topic below for
additional information.

About...
Changing Point Properties
Changing Triangle Properties
Choosing a data file
Choosing an overlay file
Close
Copy
Copyright Information
Creating a TriPlot data file
Creating a TriPlot overlay file
Cut
Deleting data from memory
Edit Menu
Entering data from a file
Entering data with the keyboard
Entering Data From the Screen
Erase Last Point
Erasing All Data From Memory
Exit
File Menu
Finding Points on the Triangle
Help Menu
Keyboard Input...
Menu commands
New
Open...
Point Color...
Print...
Printing the triangle
Refresh Points
Save
Save As..
Screen Input..
Setting the default printerThe authors
Triangle Settings...
Use the Spreadsheet to Enter Data
Warranty/Disclaimer



Exit With Changes

Exits the keyboard entry module and accepts the additions/corrections that have been made.

Note:    Be careful not to leave any blank rows after your edit.    All data entered below the blank row will 
be lost when the file is saved.

See Also:
Exiting without changes



Exit Without Changes

Exits the keyboard entry module but does not accept the additions/corrections that have been made.

Note:    Be careful not to leave any blank rows after your edit.    All data entered below the blank row will 
be lost when the file is saved.

See Also:
Exiting with changes



Cut (from the spreadsheet)

Removes the highlighted values from the spreadsheet and places them onto the Windows clipboard.

Keystroke Shortcut:    This option from the Edit menu is the same as pressing SHIFT-DELETE.

Note:    Be careful not to leave any blank rows after your edit.    All data entered below the blank row will 
be lost when the file is saved.

See Also:
Copying from the spreadsheet
Pasting to the spreadsheet



Copy (from the spreadsheet)

Copies the highlighted values from the spreadsheet and places them onto the Windows clipboard.

Keystroke Shortcut:    This option from the Edit menu is the same as pressing CNTRL-INSERT.

Note:    Be careful not to leave any blank rows after your edit.    All data entered below the blank row will 
be lost when the file is saved.

See Also:
Cutting from the spreadsheet
Pasting to the spreadsheet



Paste (to the spreadsheet)

Pastes values from the clipboard to the highlighted cells of the clipboard.    Note that you must highlight all
cells you want to paste onto.

Keystroke Shortcut:    This option from the Edit menu is the same as pressing SHIFT-INSERT.

Note:    Be careful not to have any blank rows in the spreadsheet.    All data entered below the blank row 
will be lost when the file is saved.

See Also:
Manipulating the spreadsheet
Copying from the spreadsheet
Cutting from the spreadsheet



Adding Rows to the Spreadsheet

The spreadsheet used for the keyboard input form can only hold 900 points.    Although each TriPlot 
triangle can hold 32,000 points, we recommend that you keep your files below 900 points.    Files can be 
easily combined by opening each file into the active triangle.    We hope to bypass this limitation in future 
releases. 



The TriPlot Screen

For information on a part of TriPlot, click on the appropriate portion of the screen.



Ordering and Registering TriPlot 2.1

This verison of TriPlot is "Shareware", it is not "FreeWare". You are entitled to use TriPlot for 30 days.    If, 
after 30 days, you find the program valuable to you, you must register the program and pay the 
registration fee.    The only way to take advantages of the benefits of being a licensed user of TriPlot is to 
register the program with the authors.

By using TriPlot you agree to the terms of distrubution, Copyright, and Warranty.

To print out this registration form, choose Copy from the Edit menu which places the selected text onto 
the Windows clipboard.    This text can then be imported to a text editor or wordprocessor and printed out.

REGISTRATION FORM FOR TRIPLOT 2.1

Name:____________________________________________________________________

Address: _________________________________________________________________

__________________________________________________________________________

____________________________________________________

Occupation: _____ Academic  _____ Government  _____ Commercial.

What are you using TriPlot for: 
____________________________________________________________________________

____________________________________________________________________________.

Overlays you need: _________________________________________________________

____________________________________________________________________________.

Graphic tools you need:  ___________________________________________________

____________________________________________________________________________.

Where did you obtain TriPlot 2.1:  ________________________________________ 

____________________________________________________________________________.

Please be sure to include your check or money order for $25.00 made payable 
to:

Steve J. Baedke



612 South Knightridge Apt. 40C
Bloomington, IN  47401



Benefits of Registering TriPlot

Registration will: 1) permit you to use TriPlot beyond the 30 day trial period, 2) give you access to limited 
user support, and 3) all bug fixes (if any) in this version will be available at no charge.    Additionally, we 
will construct one overlay for you, and send you information on updates.    We will inform you of receiving 
the registration and provide you with a registration number.

Remember:    If you register TriPlot 2.x with us, you will recieve TriPlot 3.0 for free.    TriPlot 3.0 may be a 
commercial product that is distributed through vendors.    This will likely increase the licensing price from 
the very reasonable $25 shareware price.    Help yourself (and us) and get into the upgrade line.



Creating Metafiles

New to version 2.1 of TriPlot is the "TriPlot Metafile Generator", a utility program for making metafiles from
TriPlot 2.x datafiles.    This program was developed in response to requests for the ability to create high 
quality image files other than bitmaps (*.BMP's).

The program MTRIPLOT.EXE reads TriPlot 2.x datafiles and overlay files.    Use the Copy command from
the Edit menu to copy the ternary image to the clipboard and then paste it into your graphics package 
(your graphics package will need to support isotropic Windows metafiles).    The triangle and datapoints 
(and optionally the overlay file, inner lines, and outer ticks) will be copied to the clipboard.    Axis labels are
not copied at this time so you'll need to add them from your graphics package.    Complete support for 
metafile generation, including axis labels, will be built into TriPlot 3.0.

Note: You cannot input data directly from this program, you must use TriPlot 2.x to create the datafile.



TriPlot 3.0

We are currently working on the next version of TriPlot.    The next major version will be TriPlot 3.0, minor 
upgrades will be versions 2.x.    TriPlot 3.0 is being developed in response to suggestions and comments 
from users, so please keep them coming.

Features to be included in TriPlot 3.0 are:
- each datapoint can be assigned a different color
- line weights, line styles, and line colors for overlays and triangle
- overlay can include circles and ellipses
- a legend box for identifying labels for point styles

Our wish list for TriPlot 3.0 includes:
- bezier curve support for the overlay file
- placeable text on the ternary diagram for field labels
- moveable and rotating text for axis labels

We have had limited success in developing support for bezier curves.    If you know of routines or 
references for drawing bezier curves based on X,Y data pairs please contact us via email or postal mail 
with this information.

Remember:    If you register TriPlot 2.x with us, you will recieve TriPlot 3.0 for free.    TriPlot 3.0 may be a 
commercial product that is distributed through vendors.    This will likely increase the licensing price from 
the very reasonable $25 shareware price.    Help yourself (and us) and register TriPlot now to get into the 
upgrade line.



email the authors at:
sbaedke@ucs.indiana.edu




